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wysiwyg R44 Release Notes 

Welcome to wysiwyg R44! (If you are a new user, it is recommended that you work through the Quick Start 

Guide (accessible from the Windows Start menu) in order to learn the basics of using wysiwyg.) These 

Release Notes are intended primarily for users who are familiar with wysiwyg and they provide information 

about new features, updates and bug fixes that were implemented in R44.  

Update 1: click here to see what enhancements were released with this update, and here for a list of issues 

that were fixed. 

Update 2: click here to see what enhancements were released with this update, and here for a list of issues 

that were fixed. 

Other documentation resources for wysiwyg include the Reference Guide found in the Windows Start 

menu, which provides information about all of wysiwyg’s functions and features; the Tips and Tricks section 

of our website, which offers tutorials for using various features; and our Forum, which  is the best place to 

find answers to usage questions – and/or to ask such questions. 

New Features 

Alternate Insertion Points. Much like Library Items, native 2D and 3D objects may now be inserted from all 

their corners, or other logical points. For example, a Riser may be inserted from the centre of its bottom 

surface, instead of only its bottom left corner. To select a different insertion point, simply right-click before 

placing the object. 

Quick Rigging Point Tool. This new tool streamlines updating Rigging Points’ Number, Name, Symbol Type, 

Capacity and/or Load by simply clicking on them (instead of having to access their Properties individually). It 

is found in the Tools menu > Quick Tools submenu. 

Secondary Fill option for Rigging Point Symbols. It is now possible to assign a secondary colour to Rigging 

Points’ opposing quadrants via their Properties. In addition, Rigging Points now hide any objects that are set 

(from the View’s Draw Order) to appear below them, making them easier to see. 

Texturing with Normal Map Images. Special “Normal”-type images may now be applied to objects in order 

to make them appear three-dimensional without actually modifying their geometry; the perceived visual 

effect is that of a fragmented surface, with high and low points that correctly interact with light. For 

example, adding a matching Normal Map to an object textured with an image of bricks will result in the 

mortar between the bricks appearing "lower" than the bricks themselves, and the bricks casting shadows 

onto the mortar. Click here for a sample and to learn how to use this feature. 

Light Emission Glow. This new option produces a glow effect for all Light Emitting objects; the glow does 

not cast light onto surrounding objects (continue to use Global Illumination for that purpose) but simulating 

objects such as LED tape/rope or light boxes is now more realistic. To enable it and control the amount of 

glow, access the Shaded View’s View Options > Visual Effects tab. Click here for a sample. 

Ground Smoke Edge. This new slider allows the edge of Ground Smoke to be controlled by increasing it for 

a more defined edge or decreasing it for a more blurry edge. It is found in the Shaded View’s View Options 

> Environment tab. 

https://cast-soft.com/wysiwyg-lighting-design/wysiwyg-tips-tricks/
http://forums.cast-soft.com/index.php
https://cast-soft.com/wysiwyg-lighting-design/r44/r44-normal-mapping/
https://cast-soft.com/wysiwyg-lighting-design/r44/r44-light-emission-glow/
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Ultra High Image Export. This new Shaded View export option becomes available only if the computer on 

which wysiwyg is running is equipped with more than 8GB of video RAM; exporting with this option 

enabled results in a higher fidelity/”crisper” image than available in the Shaded View, featuring more 

defined beams and less aliasing. Click here for a sample.  

AutoUpdate. Like in other software, this feature allows wysiwyg to check for updates online every time it 

starts; once an update is found, it may be downloaded and installed immediately, or postponed. It is 

strongly recommended that this option is left enabled, but if desired, it may be disabled by accessing the 

OPTIONS menu > Application Options > General tab; manual checks for Updates may be performed via the 

HELP menu, but only while on the Welcome Screen. Please note that AutoUpdate will only update the 

current version of wysiwyg; in other words, when the next version (e.g., R45) is released, its installer will 

have to be downloaded from the Members Only Area. 

Enhancements and Updates 

Improved compatibility with Blackmagic Design Video Capture Devices. Connectivity to these devices has 

been improved and streamlined: they are detected automatically and no longer require any setup after 

selecting them. As a result of the internal changes required by these improvements, the new Video Capture 

with Blackmagic Design Device option must be used to connect to them – after the input source and 

resolution have been selected through the utility that was installed together with the device’s driver. Don’t 

forget to download and install the latest Blackmagic Design driver! 

Save Multiple Renderings from the Background Rendering Manager. It is now possible to do this by 

selecting multiple completed render jobs and clicking the Save button; the resulting image file names will 

be the names of their respective render jobs. 

Layout Title Variable. This variable was added to Reports and Worksheets. After assigning it to a Smart Cell, 

the contents of that cell will be replaced with the name of the Layout into which the Report or Worksheet 

was inserted (but when viewed in the Report or Worksheet that cell will display [Layout Title]). 

Other Enhancements and Updates 

• wysiwyg is now able to import (Open/Merge) GL Transmission Format (.gltf) files. 

• Shaded View Cameras now appear much smaller. 

• Rotated text in Layouts now rotates back to horizontal while it is being edited. 

• Layouts may now be exported as images via the FILE menu. 

• The amount of Video Memory on systems utilizing AMD GPUs is now reported correctly. 

• A space has been added between Rigging Points’ Load & Capacity amounts, and the unit in which this is 

shown. 

• The default Color for the Dimensions layer (which gets created when the first Dimension is added to a 

file) has been updated to Orange, and its Print Color is now Gray. 

• The default color for the Rigging layer (which gets created when the first Rigging Point is added to a file) 

has been updated to Red. 

https://cast-soft.com/wysiwyg-lighting-design/r44/r44-ultra-high-image-export/
https://www.blackmagicdesign.com/ca/support/family/capture-and-playback
https://en.wikipedia.org/wiki/GlTF
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Enhancements in Update 1 

• Bottom Front Middle Alternate Insertion Point added to Risers. 

• Focus Positions are now sorted alphabetically. 

• Checks are now performed to ensure that fixtures are not patched beyond the end of the DMX 

universe. 

Enhancements in Update 2 

• Increased performance when pre-visualizing with consoles connected to wysiwyg via drivers provided 

by their manufacturers; performance should be similar to that observed while connected to the same 

via the Art-Net or sACN drivers provided with wysiwyg. 

• More fixtures’ Barndoors, Shutters and other properties may now be adjusted via the Cuts and 

Adjustments Tool. 

• Quick Light Emission tool now warns when the end of the universe is reached – and no longer allows 

over-patching. 

• Improvements to alphanumeric sorting in Reports and Focus Positions dropdowns (Focus Designer 

Tool). 

• Reports that have been inserted onto Layouts now update when the Scene is changed via the Layouts’ 

Scene toolbar. 

• The %Scene% variable in Layouts’ Text Items now follows these rules: 

• When ALL Scene-dependent items on the Layout are set to the same Scene, Text Items on that Layout 

which contains the %Scene% variable will display the name of that Scene. 

• When Scene-dependent items on the Layout are set to different Scenes, Text Items on that Layout 

which contains the %Scene% variable will display the word “Multiple”. 

• When Scene-dependent items on the Layout are set to ‘Follow User Scene’, Text Items on that Layout 

which contains the %Scene% variable will display the name of the current Scene.  

• The list of mirrorable truss pieces has been expanded. 

Fixed Issues 

• The selected Camera Path is no longer deselected when switching between modes. 

• Truss no longer disappears when Truss Indicators are enabled. 

• Reports now export correctly to .CSV files. 

• Grip stands may now be mirrored. 

• Attempting to insert (hang) a Mountable Yoke no longer leads to a crash. 

• In most cases, menus and other user interface elements should no longer become unresponsive while 

video is playing; this may still happen when using very complex files. 

• Various crashes related to Custom Conventional Fixtures to which Aliases have been assigned, have 

been resolved. 
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• Circuit Names are now printed onto pipe tapes. 

• All Production Team Info Favorites are now correctly saved. 

• Truss that should not be mirrorable (i.e. non-symmetrical pieces) can no longer be mirrored (and 

therefore cause fixtures to behave incorrectly). 

• Batch printing or Printing to PDF no longer results in a crash when using files that contain large 

amounts of fixtures. 

• Patch Addresses are now assigned correctly when using Quick Tools with Custom Increment to patch 

multi-circuit fixtures. 

• Multiple sorting issues in Spreadsheets and dropdowns have been addressed. 

• SketchUp models now always import at the correct scale. 

• Users of the MADRIX Connectivity Driver for MADRIX 3.x (not for MADRIX 5) will no longer experience 

issues with wysiwyg starting up, which were a result of this driver being installed. 

• The crash experienced when a Report or Worksheet cell contained more than 255 characters has been 

resolved. 

• The limit of usable Motion Control Axes has been increased to 2,048.  

Fixed Issues in Update 1 

• Collada (.dae) import once again. 

• Fixtures saved within Insertables insert at the intended coordinates. 

• White-colored objects no longer disappear against a white Background when selected. 

• When set to Center, a Modified Arc’s Insertion Point always appears where it should be. 

• The Apply button in the Fixture Attributes Layout window applies changes only to the current view (i.e. 

Top, Front or Side) instead of all. 

Fixed Issues in Update 2 

• Ultra High Quality image exporting is now available on SLI systems. 

• Ultra High Quality images may now be exported when connected to a console. 

• Accessing Shaded Views will no longer cause a crash as a result of a corrupted Camera. 

• The Current Layer remains the same regardless of how Scenes are changed (i.e. via the Scene Toolbar, 

by keyboard shortcuts or by DMX). 

• When using AutoFocus with the grandMA 2 console, fixture selection is once again displayed on the 

console when fixtures are selected in wysiwyg.  

• The %LayoutTitle% variable’s value is now captured when printing to PDF. 

Library Additions and Updates 
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Click here for a complete list of additions and updates to the R44 Library. (This list includes Library changes 

from Update 2.) 

Known Issues 

Click here for a list of all other known issues. Don’t forget to check this page often for updates. 

Other Useful Information 

Compatibility with Vivien 

wysiwyg R44 is fully compatible with Vivien 2020, and vice versa. Therefore, a Vivien 2020 file will open in 

R44 (and R44 files will open in Vivien 2020). Note: in order to correctly open a Vivien file in wysiwyg, you 

must download and install the Vivien 2020 Compatibility Pack for wysiwyg R44. 

System Requirements 

Click here for the current system requirements. Note that as of this release, the Windows 7 and Windows 

8.1 operating systems are no longer supported. If you are looking to purchase or build a new workstation 

for wysiwyg, reading our Hardware Guide is strongly recommended. 

Membership Requirement 

In order to use R44, the Membership on your dongle must expire no earlier than December 2019. 

Copyright Information 

© The CAST Group of Companies Inc. 2004-2020. All rights reserved. 

35 Ripley Avenue, Suite 1 

Toronto, Ontario 

Canada M6S 3P2 

“wysiwyg”, “Vivien” and “CAST Software” are registered trademarks of CAST Group of Companies 

Incorporated. Other brands or products are the trademarks or registered trademarks of their respective 

holders and should be treated as such. 
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